
What is FTP Icon Connection?
FTP Icon Connection allows you to access an Internet FTP server with an easy to use graphical user interface. With 
FTP Icon Connection, you can transfer files or define FTP servers as a repository for backing up your files (through 
WebStor). You can transfer or back up files "on the fly," or define unlimited custom FTP server connections.

FTP Icon Connection integrates seamlessly with the Windows Explorer interface, and features standard Explorer 
operations. All screens and menus look and work like the Windows Explorer.

Note: In order to use FTP Icon Connection, you must register your software with J    Technology Inc. and obtain a 
valid activation key number.



Basics For Getting Started
To use FTP Icon Connection, you must:

be familiar with Windows 95 Explorer
have an Internet connection (dial-up or direct access)
establish or have at least one account with an FTP server. 

Some familiarity with File Transfer Protocol is helpful, but not necessary.



FTP Icon Connection Menus
The FTP Icon Connection main screen contains standard Windows Explorer pull-down menus. 

The File menu options allow you to open    "ad hoc" FTP sessions that you may not wish to save. You can 
also close connections, change files or folders, delete Connection Wizard profiles, define new Connection Wizard 
profiles, designate files to transfer, and define the transfer mode. File transfer sessions performed using the File 
menu/Connection Profile are not saved.

The Edit menu allows you to define custom FTP sessions or to find files.
The View menu controls the way FTP Icon Connection displays the contents of the main screen, similar to 

Windows Explorer. For more information on display options, refer to the Windows Explorer online help file.
The Preferences menu takes you to a set of tabbed property sheets to define connection parameters, 

including Program, Transfer and Display options. The Firewall tabbed page is used only if you have activated the 'Use
Firewall' checkbox in the Connection Profile or Connection Wizard property sheets.

The Help menu contains information about registering your copy of FTP Icon Connection, release and 
version information, activation information, and J - Technology Inc. contact information.
See Also:
Registering your copy of FTP Icon Connection



Defining an FTP Server Connection
You can define a connection with an FTP server in two ways:

Use the Connection Profile to define temporary session profiles.
Use the Connection Wizard to customize multiple permanent FTP server connections by generating icons 

and folder names of your choice.
See Also:
Defining a temporary FTP connection profile 
Defining a custom connection profile  



Transferring Information
Transferring information consists of downloading    files    or uploading files. You can define folders and files to transfer
or use drag and drop to identify files to transfer.

See Also:
Downloading Files
Uploading Files



Downloading Files
Before you download files, you must first be attached to the Internet, using an FTP connection. Refer to your Internet 
provider documentation or your system administrator for directions on establishing this connection.

1. Choose File/Download.

2. Do one of the following to select the files to download:

Define the FTP destination folder in the 'Look In' field and    double-click the file you want to download.
Or

Drag the file or folder from the FTP server to your desktop or directory/folder in the Windows Explorer.
3. Click Download to transfer the selected files.

See Also:
Uploading Files



Uploading Files
Before you upload files, you must first be attached to the Internet, using an FTP connection. Refer to your Internet 
provider documentation or your system administrator for directions on establishing this connection.

1. Choose File/Upload.

2. Do one of the following to select the files to transfer:

Define the folder where the files to be transferred are located in the 'Look In' field. Then double-click the file 
that you want to upload.
Or

Drag the file or folder that you want to transfer to the FTP Server folder.
3.Click Upload to transfer the selected files.

4.To terminate an FTP session, choose File/Close Connection and click OK.

See Also:
Downloading files



Changing Directories
Once you have established an FTP connection through the Connection Profile or the Connection Wizard, you can 
change directories/folders on the FTP server.

1. Choose File/Change/Directory.

2. In the 'Change Directory to:' field, enter the new directory.

3. Click OK to change directories.



Changing File Access Rights
You can change the access levels to your folders. If you are allowing users to access shared files for transferring you 
may want to limit the ability to change a file or launch an application. You assign Read, Write and Execute levels to 
Owners, Groups, or Others.

1. Choose File/Change/Permissions.

2. In the 'File/Directory Name:' field, enter the file or directory/folder you want to define permissions for.

3. Set one of the following checkbox options for each of the 'Owner,' 'Group' and 'Other' group boxes:

The 'Read' checkbox enables the owner, group, or other category to be able to view the files in the folder but
prevents them from changing the files or launching any program. 

The 'Write' checkbox makes it possible to both view and change the file. 
The 'Execute' checkbox makes it possible to launch an programs located in the folder.

4. Click OK to accept the settings, or Cancel to exit the Permissions dialog box and return to the FTP server primary 
window. 



Deleting Configurations
1. Select the connection profile icon(s) you wish to delete.

2. Choose File/Delete.

3. Click Yes or Yes to All to delete the selected profiles.



Closing a Server Connection
When you are finished with an FTP session, you must terminate the connection to the FTP server.

1. Choose File/Close Connection.

2. Click OK to terminate the FTP server connection.



Defining a Temporary FTP Connection Profile
The Connection Profile dialog box allows you to define temporary FTP connection profiles. Before establishing a 
temporary connection, you must define the file transfer mode.

1. Choose File/Open Connection.

2. Define parameters in the following fields.

Host Name
User ID
Password
Initial Directories Remote Host

3. Select one or more of the following checkboxes.

Anonymous Login
Save Password
Use Firewall .

4. Click Connect to establish the FTP connection. 

Settings established in the Connection Profile dialog box are temporary and are used only for the active connection. 
These settings are not saved when the connection is closed.

See Also:
Defining the file transfer mode 
Setting preferences
Transferring information
Setting up Firewall parameters
Customizing FTP connections



Defining Transfer Modes
Transfer Modes are the FTP formats supported by FTP Icon Connection. 

1. Choose File/Transfer Mode.

2. Select one of the radio buttons in the Transfer Mode group box.

Select 'Auto Detect'    if you want FTP Icon Connection to automatically determine the format for file transfer.
Select 'Binary' if only binary files will be transferred.
Select 'ASCII' if only ASCII files will be transferred.
Select 'L8' if only EBCDIC files will be transferred.
Select 'Prompt'    if you want the the Transfer Mode dialog box to be displayed prior to an FTP server 

connection.
Note: One of the Transfer Mode group box radio buttons must be selected. The default and recommended setting 
is 'Auto Detect.'

3. Click OK to accept the transfer mode selection.



Customizing FTP Connection Parameters
The Connection Wizard allows you to define connection parameters for specified FTP servers. The connection 
profiles you create are displayed in the FTP Icon Connection window. You can then select one of the custom 
connections by double-clicking the appropriate icon.

1. Choose File/New or Edit/Connection Wizard.

2. Define parameters in the following fields.

Profile Name
Profile Icon
Host Name
User ID
Password
Initial Directories Remote Host
Initial Directories Initial Local

3. Check one or more of the following options:

Anonymous Login
Save Password
Prompt Prior To Connect
 Use Firewall.

4. Click Save to save the Connection Wizard configuration. This configuration will appear as an icon in the FTP Icon 
Connection primary window

See Also:
Defining a Temporary Connection Profile
Setting Preferences
Transferring Information
Setting up Firewall Parameters



Changing Customized Configurations
You can change existing Connection Wizard profiles at any time.

1. Highlight the icon for the FTP server connection you want to change.

2. Choose File/Properties.

3. Make the desired changes to the Connection Wizard profile.

4. Click Save to preserve the Connection Wizard. 

See Also:
Customizing an FTP Connection profile



Defining and Saving Connection Parameters
FTP Icon Connection enables you to define and save connection parameters. 

1. Select Preferences    to open the Program Options window. 

2. Select one or more of the following tabbed dialog pages and define the associated connection parameters.

Program Options
Transfer Options
Display Options
Firewall Parameters.

Note: All settings defined in Preferences/Program Options apply to Connection Profile and Connection Wizard 
sessions and are saved until reconfigured.

See Also:
Defining Program Options
Defining Transfer Options
Defining Display Options
Setting Up Firewall Parameters



Defining Program Options
1. Choose Preferences/Program Options.

2. Define parameters in the following fields.

 E-Mail Address
 Receive Bytes
 Send Bytes
 Port
3. Click Save to preserve the settings. 

Program Option settings are saved as defaults until reconfigured.



Defining Transfer Options
1. Choose Preferences/Transfer Options.

2. Define desired settings in the following group boxes.

 Default Transfer Mode
 Double Click Options
 Treat Links As'
 Default Directories/Files
3. Click Save to preserve the Transfer Options. 

Transfer Option settings are saved as defaults until reconfigured.

See Also:
Default Transfer ModeDefining_Transfer_Modes



Defining Display Options
1. Choose Preferences/Display Options.

2. In the 'Default View' group box, select one of the Default View radio. One of the radio buttons must be selected.

3. In the 'Miscellaneous' group box, select the 'Sound' checkbox if you want FTP Icon Connection to beep when any 
file transfer session is complete.

4. Click Save to preserve the Display Option settings. 

Display Option settings are preserved as defaults until reconfigured.



Setting Up Firewall Parameters
To set up firewall parameters, the 'Use Firewall' checkbox in the Connection Profile or Connection Wizard dialog 
windows must be selected. You must obtain firewall configurations from your local network or ISP Systems 
Administrator.

1. Choose Preferences/Firewall.

2. Define parameters in the following fields.

 Host Name
 User
 Password
 Port
3. In the 'Firewall Type' group box, select the appropriate Firewall Type.

4. Select the 'Save Password' checkbox to save your password for future firewall configurations.

5. Click Save to store the firewall configurations as default. 



Registering FTP Icon Connection
You must register your copy of FTP Icon Connection and obtain activation keys from J    Technology Inc. prior to 
establishing FTP server connections. You can register by mail or online. Activation keys will be transmitted upon 
verification of your online registration, or receipt of your mail registration and fee.

1. Choose Help/Register FTP Icon Connection Online.

2. In the personal information fields, enter your name, address, and e-mail address.

3. In the 'Credit Card Information' group box, enter your credit card type, card number, and expiration date.

4. In the 'Please send me' activation key request field, enter the number of activation keys you desire.

5. Click Submit to transmit your registration.

See Also:
Activating FTP Icon Connection



Activating FTP Icon Connection
1. Choose Help/About/Registration Information.

2. In the 'Enter Your Activation' fields, enter your FTP Icon Connection activation key number.

3. Click Validate Registration or Register Online.

1. Click OK to accept the validation.

See Also:
Registering FTP Icon Connection



Host Name field: FTP server (IP, FTP or Domain name). 



User ID field: User FTP login account name (or “anonymous”). 



Password field: User e-mail address. 



Initial Directories Remote Host field: User defined directory (folder) path name for FTP server. 



Initial Directories Initial Local field: User defined directory (folder) path name for user computer. 



Anonymous Login checkbox: Enables Anonymous FTP login. 



Save Password checkbox: Enables Save Password (e-mail address) for future sessions. 



Use Firewall checkbox: Requires firewall parameters to be defined. 



Prompt Prior to Connect: Displays Connection Wizard profile parameters prior to connection. 



Change Icon button: Activates Change Icon screen. 



E-Mail field: User e-mail address. 



Receive Bytes field: Defines transmission byte reception parameter; recommended default setting is 4096. 



Sent Bytes field: Defines transmission byte send parameter; recommended default setting is 512. 



Default Directories/Files Down Load field: Defines FTP server default files for download. 



Log File checkbox: Enables log file recording of FTP sessions. 



Save File On Double Click checkbox: Enables file save by double click. 



View File On Double Click checkbox: Enables file open by double click. 



Host Name field: Defines local firewall host name. 



User name field: Defines local firewall user name. 



Password field: Defines local firewall e-mail address. 



Port field: Defines local firewall port. 



Site Hostname firewall radio button: (must be defined by network or ISP Systems Operation). 



User After Login firewall radio button: (must be defined by network or ISP Systems Operation). 



User With No Login firewall radio button: (must be defined by network or ISP Systems Operation). 



Proxy Open firewall radio button: (must be defined by network or ISP Systems Operation). 



Popup topic for Icon List in Icon Selection dialog. 



Popup topic for Select button on Icon Selection dialog. 



Popup topic for Cancel button on Icon Selection dialog. 



Log File field: Log file path name and file name. 



Host Name field
Internet Protocol (IP) address, FTP address, or domain name.



User ID field
FTP account name (FTP login or "anonymous")



Password field
User e-mail address.



Initial Directories Remote Host field
FTP server path name and folder.



Anonymous Login checkbox
Enables Anonymous FTP profile connections.



Save Password checkbox
Saves password for future sessions.



Use Firewall checkbox
Must be checked if your ISP or local network uses a firewall.



Profile Name field
User defined FTP session name.



Profile Icon selection
User defined FTP profile icon.



Initial Directories Initial Local field
User host computer path and file name for default file transfers.



Prompt Prior to Connect checkbox
Causes Connection Wizard to display prior to FTP server connection.



Receive Bytes field
Recommended default is 4096.



Send Bytes field
Recommended default is 512.



Port field
Recommended default is 21.



Double Click Options group box
Enables file save on double click, and/or enables file view on double click.



Treat Links As group box
Treats links as files or folders.



Default Directories/Files group box
Defines the download default directory and file name.

The Log File checkbox enables creation of FTP session logs; the log file will appear in the directory and file entered in
the Log File field.



Firewall Host Name field
Firewall IP, FTP or domain name.



Firewall User field
Firewall user name.



Firewall Password field
Firewall password.



Firewall Port field
Firewall port number.



FTP
File Transfer Protocol allows you to back up files to a server via the Internet.



Repository
The location where you want your backed up data to be stored. This can be either a local disk drive, a mapped 
network drive or a folder on an FTP server. 



Firewall
Provides security for a network in an Internet environment. If a user tries to access a network protected with a 
firewall, the firewall verifies the username and password to insure that the user is authorized to access the network.



ISP
Internet Service Provider



E-Mail Address
User internet or on-line service electronic mail address.



Downloading
transferring files or folders from the FTP server to your computer



Uploading
transferring files or folders from your computer to the FTP server




